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Chapter 1

. Introduction

1.1 What is ILWIS for Windows

ILWIS is a Windows-based, integrated GIS and Remote Sensing application
consisting of:
n Display of raster and multiple vector maps in map windows
n Display of tables in table windows
n Interactive retrieval of attribute information
n Image processing facilities
n Manipulation of maps in a Map Calculator
n Manipulation of tables in a Table Calculator
n GIS analysis tools
n Script language to perform 'batch' jobs

ILWIS functionality for vectors includes: digitizing with mouse and/or digitizer,
interpolation from isolines or points, calculation of segment or point density, pattern
analysis.

ILWIS functionality for raster includes: distance calculation, creation of a Digital
Elevation Model (DEM), calculation of slope/aspect, deriving attribute maps,
classifying maps, manipulating maps with iff-statements, with Boolean logic,
crossing maps, etc.
For satellite imagery: creation of histograms, color composites, sampling and
classification, filtering, multi-band statistics.

Furthermore ILWIS provides import and export routines, editing of point, segment,
polygon and raster maps, change of projection/coordinate systems of maps, and
output possibilities with annotation.

With Windows, you can start one operation and keep it running while you start one
or more additional applications. This is a sort of multitasking. You may work with
both Windows and DOS application programs, you can perform one or more ILWIS
calculations in the background and at the same time display maps, run other ILWIS
operations, print, etc.

ILWIS 2.1 for Windows is designed for Windows 3.1, Windows 3.11 and Windows
for Workgroups. ILWIS 2.1 for Windows also runs under Windows '95 and under
Windows NT. To install ILWIS 2.1, see Installation Guide.
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1.2 When you are new to Windows

When you are new to Windows you might have to learn some basic Windows
terminology and techniques. To acquaint yourself with Windows you can run the
Windows Tutorial and read parts of the Windows User's Guide.

The following Windows terms and techniques should be familiar to you:
minimize, maximize, moving windows, sizing windows, title bar, menu bar, using
scroll bars, using menus.

1.2.1 Windows features introduction
To learn and practice basic Windows functions, it is recommended to run the
Windows Tutorial, included in your Windows program. The Windows Tutorial can
be found on the Help menu of Windows Program Manager. It is also recommended
to read the MS Windows User's Guide.

The map windows, table windows etc., in which ILWIS displays data, have some
common Windows features:

Moving a window
A window can be moved over your desktop by dragging the title bar of a window to
a new position: place the mouse pointer on the title bar, press the left mouse button
and hold it down, and move the mouse pointer to a new position, then release the left
mouse button.

Changing the size and shape of a window
A window can be sized by dragging its borders. Select the window you want to
resize, point to a border or a corner of a window, the cursor changes into a two-
headed arrow, drag (press the left mouse button and hold it down) the border or
corner until the window is the size you want, then release the mouse button.

A window cannot be resized when a map or table is already entirely displayed in a
window. Resizing a window is possible when the border of a window consists of
double lines.

Maximize
A window can be enlarged to the full size of your screen:
n by clicking the maximize button (the delta-up button at the upper-right corner of

a window), or
n by clicking the Control-menu box in the upper-left corner of a window to open

the Control menu, select the Maximize command, or
n by double-clicking the title bar of a window.
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To restore a window, double-click the title bar again. When two or more windows
are open and you maximize one of them, all the others are covered up by the
maximized one.

Restoring a window to its previous size: (after maximize)
A window is restored to its previous size by clicking the restore button, i.e. the
double-delta button at the upper-right corner of a maximized window. You can also
restore a window to its previous size by double-clicking the title bar. Another way is
to click the Control-menu box and select Restore from the menu.

Minimize
A window can be reduced to an icon on the desktop if you want the window or
application available for later use. To reduce a window to an icon:
n click the minimize button (the delta-down button at the upper-right corner of a

window), or
n click the Control-menu box in the upper-left corner of the window to open the

Control menu, select the Minimize command.

After a window is reduced to an icon, you can select and move the icon in the same
way you select and move a window. See also: icons of minimized ILWIS windows.

Restoring an icon: (after minimize)
An icon can be restored to a window by double-clicking it. You can also click the
minimized icon and select Restore from the Control menu.

Using scroll bars
When an ILWIS map or table cannot be entirely displayed in a window, scroll bars
appear at the right and/or bottom of the window. You may have both a horizontal
and vertical scroll bar or only one of them, depending on the size of your map/table
in the window. You can use the scroll bars to view information that does not fit in
the window.

The buttons with the arrows are called scroll arrows, the area between the scroll
arrows is called the scroll bar, and the button in the scroll bar is called the scroll box.
The best ways to use the scroll bars in ILWIS are:
n Click above or below the scroll box on the vertical scroll bar: the contents of the

window will scroll vertically.
n Click to the left or right of the scroll box on the horizontal scroll bar: the

contents of the window will scroll horizontally.
n Drag the scroll box in a scroll bar to the position you want. The section of the

map/table that moves into view depends on where you position the scroll box.
For example, if you position the scroll box half way down the vertical scroll bar,
the contents halfway the map/table appears.

Using scroll bars can be convenient when you have zoomed in on a map.
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Closing a window
A window can be closed:
n from the File menu, choose Exit,
n by double-clicking the Control-menu box,
n from the Control menu, choose Close, or
n by pressing Alt+F4 on the keyboard.
When you close the ILWIS Main window, you will close all ILWIS windows and
leave ILWIS. When you close an ILWIS data window, you close the window in
which a map, table, or pixel information is displayed.

1.2.2 Parts of a window
Most windows have certain elements in common, such as a title bar and a menu bar.
Not all windows, however, have every element.

The Control-menu box is in the upper-left corner of each window. Click the Control-
menu box to open the Control menu. The Control menu is most useful if you use the
keyboard rather than the mouse to move, size, and close a window.

The title bar shows the name of the application, map, or table. If more than one
window is open, the title bar of the active window has a color and intensity different
from other title bars.

The menu bar contains available menus from which you can choose commands.

The scroll bars enable you to move through a map or table when the entire map or
table does not fit in the window. Click the scroll arrows with the mouse to move
through a map or table.

Clicking the Maximize button with the mouse enlarges the active window so that it
fills the entire desktop; clicking the Minimize button reduces your window to an
icon. You can also use the Maximize and Minimize commands in the Control menu.

The Restore button replaces the Maximize button after you enlarge a window.
Clicking the Restore button returns the window to its previous size. You can also
use the Restore command in the Control menu.

The window border is the outside edge of a window. You can change the size of a
window by lengthening or shortening the border on each side of a window. You can
only resize a window when just a part of the map or table is displayed in a window.

Moving the window corner shortens or lengthens two adjoining sides of a window
border at the same time. You can only resize a window when just a part of the map
or table is displayed in a window.
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The insertion point (a flashing vertical bar) marks the place where text appears when
you begin typing.
The mouse pointer or cursor appears if you have a mouse installed. When you move
the mouse, the position of the pointer changes on the screen. The shape of the
pointer/cursor may vary, e.g. normally an arrow, but a little hand when in a map
editor.

The status line is shown at the bottom of a window. The status line gives short clues
on menu commands, on the effect of buttons in the button bars, and in some cases
displays additional information on actions in a window.

See also section 1.2.1 Windows features introduction.

1.2.3 Using a menu
Open a menu by clicking a name of a menu in the menu bar. The items displayed on
a menu are called commands. You can click the menu item you want to use. You
can also drag the mouse pointer down the menu until the menu item is highlighted
and then release the mouse button. While selecting a menu command, the status line
gives a short explanation on the effect of the command.

F To move directly to a command on a menu, type the letter that is underlined in the
command name.

Menu conventions
Dimmed menu commands.

You cannot use the menu command at the current time. (For example, you may
need to select another item before you can use this command.)

An ellipsis (...) following a command.
A dialog box appears when you choose the command. The dialog box contains
options you need to select before the command can be carried out.

A check mark (√) to the left of a command.
The command is in effect. When you remove the check mark (by choosing the
command again), the command is no longer in effect.

A key combination (e.g. CTRL+I ) to the right of a command.
The key combination is a shortcut for choosing the command. You can press the
keys listed to choose the command without first opening the menu. (CTRL+I
means Zoom In on a map window.)

A triangle ( ) to the right of a command.
When you choose this command, a cascading menu or submenu appears.
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Context-sensitive menus
A context-sensitive menu lists commonly used menu commands. Selecting a
command from a context-sensitive menu is a short cut for selecting a normal menu
command.
In ILWIS, a context-sensitive menu appears by clicking the right mouse button
when the mouse pointer is located:
n on an object in the Catalog: lists commands to display, edit, copy, delete the

object or to view and edit the properties of an object, allows you to obtain short
Help on this object, and lists the operations which can be performed on the
object.

n on an operation in the Operation-list: allows you to start the operation, or to
obtain short Help on this operation.

n in a map window: gives some short cuts to Select an area in a map, to go to
Layer Management, or to change the Double-click action. Further, all data and/or
annotation layers used in that map window are listed: select a layer to change its
display options.

n in an editor: lists editor-related actions.

1.2.4 Control menu
With the Control menu you can close, minimize or maximize a window, restore an
icon to a window etc., The Control menu is especially convenient if you use the
keyboard rather than the mouse. Open the Control menu for a window by selecting
the Control-menu box in the upper-left corner of a window, or press Alt+Spacebar
on the keyboard. For an icon, you open the Control menu by selecting the icon.

Control menu commands
Restore  Restore a window to its former size after you have enlarged

(maximized) it or reduced (minimized) it to an icon.
Move  Move the window to another position by using the keyboard.
Size Change the size of the window by using the keyboard.
Minimize Reduce the window to an icon.
Maximize Enlarge a window to its maximum size.
Close Close the window. If you close the ILWIS Main window, you close all

ILWIS data windows and you exit ILWIS.
Switch to ... Open Task List, which enables you to switch between running

applications and to rearrange windows and icons on your desktop.
ILWIS Switch to ILWIS Main window.

When you double-click the Control-menu box in the ILWIS Main window, you
close all ILWIS windows and you exit ILWIS. When you double-click the Control-
menu box in an ILWIS data window, you close that data window. When you double-
click an icon, the icon is restored to a window.
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1.2.5 Using a dialog box
A dialog box appears when you need to supply additional information to complete a
task.

Most dialog boxes contain options you can select. After you specify options, you
can choose the OK button to carry out the command. Some dialog boxes may
display information, warnings, or messages indicating why a requested task cannot
be accomplished. You can move a dialog box to another location on the screen by
dragging its title bar.

To move within a dialog box
The currently selected option within a dialog box appears as a highlight, a dotted
rectangle, or both.

To move to another option in a dialog box
n click the option or area with the mouse, or
n press Tab to move to the next, or Shift+Tab to move to the previous option or

area.

If the option, box, or button has an underlined letter in its name, you can choose that
item by pressing and holding down Alt while typing the underlined letter.

Dialog box options
A dialog box can contain the following options:

Command buttons
A command button initiates an action, such as carrying out or canceling a command.
The OK, Cancel and Help buttons are common command buttons. They are often
located along the right side of a dialog box.

The currently selected button has a border that is darker than that of other buttons.
Unavailable options appear dimmed.

Example of a command button:

To choose a command button:
n click the desired command button with the mouse, or
n press Tab until the button you want is selected, then press Enter.

Text boxes
In a text box you type information. When you move to an empty text box, an
insertion point (a flashing vertical bar) appears. The text you type starts at the
insertion point.
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If the box you move to contains text, and the text is highlighted, any text you type
will replace it. You can also delete existing text by pressing the Del or Backspace.

Example of a text box:

To select text in a text box:
n drag the pointer across the text, or double-click a word to select one word at a

time, or
n position the mouse pointer in the text box and press and hold down Shift while

pressing an arrow key.

List boxes
A list box displays a list of choices. If there are more choices than can fit in the box,
scroll bars are provided so you can move quickly through the list.

Usually, you can select one item in a list box.

Example of a list box:

To select an item with the mouse:
n click the up or down scroll arrow, or drag the scroll box until the item you want

to select is displayed,
n click the item.

To select an item by using the keyboard:
n press the Up Arrow or Down Arrow key to move through the available options

until you reach the one you want.

Drop-down list boxes
A drop-down list box initially appears as a rectangular box containing the current
selection. When you select the down arrow in the square box at the right, a list of
available choices appears. If there are more items than can fit in the box, scroll bars
are provided. In ILWIS, you will sometimes find at the right end of a drop-down list
box, a so-called create button. When you click on the create button, an object can be
created.

Examples of a drop-down list box: (the picture below contain hotspots)
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To open a drop-down list box and select an item with the mouse:
n click the box or the arrow to open the list box,
n click the up or down scroll arrow, or drag the scroll box until the item you want

to select is displayed,
n click the item.

To select an item from a drop-down list box by using the keyboard:
n press the Up Arrow or Down Arrow key to move through the available options

until you reach the one you want.

To create an object with the create button:
n click the create button (rising sun) at the extreme right of the list box.

Option buttons
Option buttons represent a group of mutually exclusive options. You can select only
one button at a time. If you already have one option selected, your current selection
replaces it. The selected option button contains a black dot. Names of unavailable
options appear dimmed.
Example of option buttons:

To select an option button:
n click the option button or press the Spacebar.

If the option has an underlined letter, you can select the option button by pressing
and holding down Alt while typing the underlined letter.

Check boxes
A check box presents non-exclusive options: you can select as many check box
options as needed. When a check box is selected, it contains an X. Names of
unavailable options appear dimmed.

Example of a check box:

To select or clear a check box:
n click the check box with the mouse, or press the Spacebar.

If the option name has an underlined letter, you can select or clear the check box by
pressing and holding down ALT while typing the underlined letter.
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1.3 Getting started with ILWIS for Windows
When the ILWIS icon is double-clicked in Windows Program Manager, the ILWIS
logo appears, followed by  the ILWIS Main window.

The picture below contains hotspots wit additional information:

Main window
Just below the menu bar you see a line in which text appears as soon as you click a
map or menu command. This is the command line, on which you can type for
example MapCalc statements. Below the command line is a button bar which allows
you to quickly display maps or tables. If you want to change to another directory or
drive you can use the navigator: the list boxes to the right of the button bar.

The central right part of the Main window is the Catalog. It
displays the ILWIS objects in the current directory. All ILWIS
objects are preceded by an icon. The icons preceding data
objects are:

for map lists,
for raster maps,
for polygon maps,
for segment maps,
for point maps,
for tables.
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To see more objects in the Catalog than only data objects, see How to customize the
Catalog. For a list of all ILWIS objects and their icons, see ILWIS objects. For short
Help on an object in the Catalog, click an object with the right mouse button and
choose Help from the context-sensitive menu.

Below the Catalog, you find a scroll bar which you can use to view more objects of
the current directory in the Catalog.

The left part of the Main window is the Operation-list. It contains all ILWIS
operations preceded by an icon. To the right of the Operation-list, you find a scroll
bar which you can use to view more operations.

At the bottom of the Main window you see the status line which gives additional
information on maps, tables, operations, etc. The Main window can be sized by
dragging its borders.

Displaying maps and tables
There are several ways to open a map or table in a window:
n open the File Menu, choose the Open command, and select a map or table to

display, or
n double-click a map or table in the Catalog.

Other ways to display maps and tables are by using the button bar, the context-
sensitive menu under the right mouse button when the mouse pointer is positioned
on a map or table, or by double-clicking the Show item in the Operation-list. When
opening a map, a dialog box appears in which you can specify some display options
for the map.

A map is displayed in a map window. You can open as many map windows as you
like. A map window can display one raster map, one or more vector maps, or one
raster map with one or more point, segment, and polygon maps and annotation. You
can zoom in and out, and if the map does not fit in the map window, you can scroll.
You can add other maps to an existing map window, either by dragging the desired
map from the Catalog to the existing map window, or by using the Add Data Layer
command on the Layers menu of the Map window. To see the value or meaning of a
pixel, point, segment, or polygon of displayed maps in a map window, you can press
the left mouse button (info). When the displayed map has an attribute table, you can
double-click in the map window to see and edit the attributes. To add or to remove
layers from a map window, or to change display options of a layer, you can use
Layer Management command on the Layers menu. Multiple map and annotation
layers displayed in a map window can be saved as a map view.

A table is displayed in a table window. You can open as many table windows as you
like. Each table window displays one table. A table can be shown as a whole, or
record by record. When the table does not fit in the table window, you can scroll.
Fields in a table can be edited by clicking them. The width of a column and the order
of columns can easily be changed. From a table window, you can create graphs in a
graph window.
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Pixel info
In the pixel information window you can get information on multiple maps and
attribute tables which contain attribute data. Open the pixel information window
through the command Open Pixel Info on the File menu of the Main or a map
window. Add one or more maps to the pixel info window by using the File menu of
the pixel info window, or drag map icons from the Catalog to the pixel information
window.

Starting ILWIS operations
ILWIS operations, such as Distance calculation or Filter, are listed in the Operation-
list. There are four ways to start an ILWIS operation:
1. Open the Operations menu in the Main Window and choose an operation , or
2. Double-click an operation in the Operation-list, or
3. Press the right mouse button on an object in the Catalog: a context-sensitive

menu appears from which you can choose an operation, or
4. Drag an ILWIS data object from the Catalog to an operation in the Operation-

list.

Usually a dialog box is opened in which you can select input and output object
names and where you can set some parameters necessary for the operation. To
obtain short Help on an operation in the Operation-list, click an operation with the
right mouse button and choose Help from the context-sensitive menu.

Command lines
Map calculation formulae can be typed on the command line of the Main window,
table calculation formulae can be typed on the command line of a table window.
These command lines can also be used as a pocket line calculator. The command
line of the Main window can also be used to type ILWIS commands, ILWIS
expressions, or to run a script.

Advanced users might want to know the new functions and capabilities of ILWIS
2.1 compared to the previous version. They can start to import ILWIS 1.3 and 1.4
data.

1.4 Importing data from ILWIS 1.4
Data from ILWIS 1.3, 1.4 or 1.41 can be imported into ILWIS 2.1 for Windows.
Below, you find some preparative hints to make Import 1.4 and later ILWIS 2.1 run
smoothly. In the remainder ILWIS 1.4 is used meaning ILWIS 1.3, 1.4 or 1.41.

1. First of all, make a backup of your existing data.
2. Organize the data to be imported in one or more directories. By default, Import

1.4 is running on a whole directory. You can specify a mask to select the objects
to be imported.

It is strongly advised to take the following paragraphs into account before starting to
import 1.4.
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Importing satellite images
The .MPD and .MPI files of the satellite bands should be available. Any .HSB or
.COL files can be deleted. During Import 1.4, select domain Image for satellite
imagery.

Importing color composites
The .MPD, .MPI, and .COL  files of the color composite should be available. You
may need to save the color composite's color look up table (.COL) in ILWIS 1.4;
give it the same name as the color composite. During Import 1.4, select domain
Picture for color composites.

Importing raster maps created from vector data, and attribute tables
For the raster data, vector data and attribute tables, select during Import 1.4:
n domain Class when the elements in the original  polygon, segment or point map

are named by class names (e.g. mapping units in thematic maps). The classes
may occur in various parts in the original polygon, segment or point map. The
.MPD, .MPI, .COL and .INF files should be available for domain Class raster
maps.

n domain ID, when the elements in the original polygon, segment or point map are
uniquely named (e.g. cadastral plots). The .MPD, .MPI, and .INF files should be
available for domain ID raster maps.

n domain Value when the elements in the original polygon, segment or point map
refer to measurable values (e.g. contour lines). The .MPD and .MPI files should
be available for domain Value raster maps.

When importing polygon maps that were rasterized, the .SEG, .CRD, .TOP and
.POL files should be available. All these files should have the same name: e.g.
LANDFORM.SEG, LANDFORM.CRD, LANDFORM.TOP, LANDFORM.POL. If
this is not the case:
n create a label point file for the polygon map (SegPol),
n use CopySeg to copy those segments of which one polygon map should be

created,
n re-polygonize (SegPol),
n assign labels to the polygons (SegPol).

When importing segment maps that were rasterized, the .SEG and .CRD files should
be available. When importing point maps: the .PNT should be available. There is no
need for .SLG, .PLG, .SGC or .PLC files.

Import of attribute tables works best when attribute tables have the same names as
the maps to which they relate. Attribute tables are expected to have the extension
.TBL. In case you have your attributes in an .INF or .PNT table, it is advised to save
these as .TBL as well. Attribute tables are expected to have a Name$ column.
Attribute table can only be linked to domain Class or domain ID maps, not to
domain Value maps.
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Make sure that you select the same domain names for the vector data during import
as for the rasterized forms of these maps. Also, select the same domain names for
the attribute tables as for the maps to which they relate.

In ILWIS 2.1, polygonized segment maps are only imported as polygon maps. This
is correct: display of polygon boundaries over a raster map in ILWIS 2.1 has the
same effect as displaying segments over a raster map in ILWIS 1.4.

Importing maps obtained through calculations: For maps containing measurable
values, for example created by MCalc calculations or by interpolations, the .MPD
and .MPI files should be available. Any .HSB, .HSI files can be deleted. During
Import 1.4, select domain Value. If you have a byte map with a user-defined color
lut, see the next paragraph.

Importing maps obtained through calculations
For maps containing measurable values, for example created by MCalc calculations
or by interpolations, the .MPD and .MPI files should be available. Any .HSB, .HSI
files can be deleted. During Import 1.4, select domain Value. If you have a byte map
with a user-defined color lut, see the next paragraph.

Importing classified raster data
Byte maps containing classes are expected to have an .INF table with the class
names and a color lut .COL. Such maps may for instance be obtained by a classify
operation in MCalc using a classify table, or are output maps of an image
classification. However, maps created through a classify table do not yet have an
.INF table; it is advised to create one before Import 1.4. You could do this in ILWIS
1.4 TabCalc: create a table with as many records as classes in your map, add one
column Name$, and type the meanings of your classes for each record, save as .INF.
Of course, the same can be obtained with an editor.

As mentioned before, Import 1.4 works smoothly when the .MPD, .MPI, .COL and
.INF files are available. It is also advised that the files have the same file name, e.g.
DISTCLAS.MPD, DISTCLAS.MPI, DISTCLAS.COL, and DISTCLAS.INF.
During Import 1.4, select domain Class.
Mind: if you do not make the effort to create an .INF table beforehand, then select
domain Class or ID during Import 1.4, and edit this domain later yourself.

Importing other raster data
To import bit maps, the .MPD and .MPI files should be available. There is no need
for a .COL file. Bit maps are automatically imported with domain Bit.Scanned raster
data can be imported when the .MPD, .MPI are available. If the scanned data
consists of gray values, select domain Image during Import 1.4. If the scanned data
is in color, the .COL should also be available. Select domain Picture during Import
1.4.

Import of point tables
For point tables with a Name$ column, you can follow the instructions in paragraph
'Importing raster maps created from vector data, and attribute tables'; select domain
Class or domain ID. Point tables without a Name$ column are imported as a domain
ID map.
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Importing vector data without raster data
Vector data will rarely occur without raster data. You can follow the instructions in
paragraph 'Importing raster maps created from vector data, and attribute tables'.

Importing other tables
Tables without a Name$ column (.TBL or other extension) can be imported by
selecting domain None during Import 1.4. At the moment, Import 1.4 has no
facilities to import classify tables (.CLT) or 2-dimensional tables (.TB2).
Histograms from ILWIS 1.4 (.HSB, .HSI) can be deleted; they are recalculated in
ILWIS 2.1.

Batch files
Import of existing batch files is not possible.

To start importing maps and tables from version 1.4
Choose the Import from version 1.4 command on the File menu of the Main window
or double-click the Import 1.4 item in the Operation-list.
n Indicate for each object to be imported the domain type. When selecting domain

Class or ID, enter a name for the domain object or accept the default domain
name. The domain contains the valid class names or IDs in one or more maps.

n For raster maps, Import assigns the same georeference to all maps of the same
area. When a georeference name is asked, enter a name indicating the area.

n Give a description for each file that you import. The descriptions appear in the
title bar when the imported objects are displayed.

Import of maps and tables with more than 256 classes or IDs may take quite some
time. When Import has finished you can start to display your maps, etc., see Help
topic Getting started with ILWIS 2.1.




